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Home Energy Plus Style Guide 
 
 

1.0 Introduction 

The following information is presented as a guide for consistent usage when WECC staff 
prepares written documents for the Division of Energy Services (DES) and when placing 
information onto the Home Energy Plus Web site. The following standards will be used in all 
communication materials. Consult this guide when writing, editing, and proofing materials for 
DES.  If a question arises regarding grammar or formatting not covered in this guide, consult the 
following references. 
 
 Merriam-Webster’s Collegiate® Dictionary 

The Gregg Reference Manual 
The Chicago Manual of Style 
The Associated Press Stylebook and Libel Manual 

 
 
2.0 Basic Layout and Formatting 

2.1 Text/Fonts 

For all materials not designed by the marketing department—including letters, reports, and 
proposals —the preferred font is Arial, black, with 11 point for text. Headers are Arial font, black, 
13 point, and bold. One blank line above a header (if not first item on a page) and six (6)-point 
spacing to follow before body of text. All text is left justified. See example below. 
 
  

   Header Example  
    Insert text using Arial, black, with 11-point font. 
 
 
Exceptions include cover pages, some headers, and training announcements. Other non-serif 
fonts such as Calibri or Franklin Gothic may be used.  
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2.2 Home Energy Plus Colors 

The primary Home Energy Plus green color used on materials is Pantone 349. This color can 
also be output in CMYK and RGB mode using the color breakdowns shown below. The 
following is the RGB example located on the Home tab under font color. 
 

CMYK 
C: 100 
M: 0 
Y: 91 
K: 42 

 
RGB 

R: 0 
G: 112 
B: 60 

 
 
 
 
 
The Home Energy Plus light brown color used on materials is available in an RGB mode using 
the color breakdown shown below. The following is the RGB example located on the Home tab 
under font color. 
 

RGB 
R: 229 
G: 218 
B: 171 

 
 

 

 
 

 

 

 

2.3 Home Energy Plus Logo 

The colors used to make up the Home Energy Plus logo are Pantone 349 and Pantone Cool 
Gray 11 (70% black). The logo should not be changed in any way. When resizing is needed, the 
logo should maintain it proportions and not be distorted. 
 
2.3.1 Logo Samples 
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2.3.2 Logo Clear Space 

The Home Energy Plus logo is more prominent and visible when a generous amount of clear 
space surrounds it. It should stand out from other visual elements such as text and photos. Plan 
for placement of the logo and modify the position of other graphic elements to maintain a 
generous clear space.  
 
2.4 Public Relations Boilerplate 

The following boilerplate disclaimer should be included where feasible on reports, information 
sheets, and the training and technical assistance Web site home page. The disclaimer is usually 
located at the bottom of the back side of the cover page. 
 

Disclaimer – The findings in this report do not necessarily represent the opinions of 
the Department of Administration.  
 

 
3.0 General Formatting 

3.1 Headers and Footers 

Headers and footers are used in standard documents and manuals.    
 
3.1.1 Header Sample 

The Home Energy Plus logo (either the black or the grey and green) 

 Even pages—the logo should be on the right side of the page 

 Odd pages—the logo should be on the left side of the page 
 
 
 
 
 

3.1.2 Footer Sample 

 Even pages – the chapter number followed by an en-dash (with no space around it), 
followed by the page number on the right side of the page. 

 Odd pages – the chapter number followed by an en-dash (with no space around it), 
followed by the page number on the left side of the page. 

 
 
Even Page  
 

Wisconsin Weatherization Program Manual 1-20 
Revised: May 2012 

 
 
Odd Page  
 

1-19  Wisconsin Weatherization Program Manual 
 Revised: May 2012  
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3.2 Line, Indent, and Tab Spacing 

Standard line spacing for all documents is the normal spacing default in Word. No additional 
spacing is necessary before/after each line of text. Use tabs for consistent spacing and 
alignment. The default tab spacing in Word is .5‖.  
 
3.2.1 Sentence Spacing 

Use only one space between sentences and after colons. The use of two spaces is a holdover 
from the old days of typewriters. The static-sized font often made it difficult to see sentence 
breaks so two spaces were used to compensate. Today’s word processors automatically adjust 
letter spacing so there is no need for two spaces. 
 
3.3 Numbers vs. Bullets in Lists 

In lengthy documents such as manuals, use outline numbers or letters for lists to enable easier 
reference. 
 

Example: See Chapter 3.2.2 for the policy supporting the answer to your question. 
 
Use bullets for lists contained in a section of the document that is described by outline numbers. 
 

Example:  Chapter 4.1.2. Client files must contain: 

 applications 

 eligibility documentation 

 proof of ownership 
 
3.4 Bullets Levels 

 The first bullet level is a standard bullet set at .25 (text starts at .5‖) 
– The second bullet level is a standard en dash set at .5 (text starts at .75‖) 
 The third level is a standard arrow set at .75 (text starts at 1‖) 

 
3.5 Cover Page Template 

The following is an example of a standard report cover page. The following font sizes should be 
used. 

 Title of report – Arial 33 point and bold 

 Full Report and Date – Arial 28 point and bold 

 Prepared for and funded by – Arial 15 point, bold, and italics 

 WI DOA – Arial 15 point with no bold 

 The remaining text should be Arial 11 point font and bold where indicated  

 The Home Energy Plus logo (black logo) 
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  Sample Report Cover 
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3.6 Report Style Levels 

The report style is important when setting up a report. It enables a clean flow of the document 
with leveled headings numbered in a specific order to help the reader. 
 
3.7 Setting up a Table of Contents 

Setting up a Table of Contents can be a tedious task, but once it is set up, it will make editing of 
headings and page numbering easier.   
 
The following guidelines should be used when setting up the title for the Table of Contents: 

 Center title 

 Bold 

 Initial caps 

 Arial 13 point font 

 The title should start on the first line of the document with one blank line beneath. See 
example below. 

 

Table of Contents 

 
The Table of Contents should contain only four levels. More than four levels become difficult to 
read.  

 Start the first level with the title number and in bold at the left margin with the title text 
starting at 1‖. 

 The title headings should be as follows. 
 

 
 
 
 
 
 
 
 

3.7.1 Page Numbering the Table of Contents 

The Table of Contents should have page numbers in the footer of the document just like the rest 
of the document. The Table of Contents page numbers are usually in Roman numerals (i, ii, iii, 
and iv, etc.) The document page numbers are usually in numeric digits. 
 
3.8 Setting up Title Headings in a Document 

The chapter number and title should be as follows: 

 Bold 

 Arial 13 point font 

 The title should start on the first line of a page at the left margin. If that is not possible, 
there should be two blank lines above the chapter title and one blank line beneath it 
before the start of the text. See the following example: 

  

1.0 Level One – Title...................................................................................................... 1-1 

 1.1 Level Two – Title ........................................................................................... 2-1 

 1.1.1 Level Three – Title ...................................................................................... 3-1 

 1.1.1.1 Level Four – Title ........................................................................................ 4-1 
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Chapter 1 – Title 

 

1.0 Level One – Title  

The first title heading (example, 1.0) should start at the left margin.  

 The title should begin at 1‖ from the left margin.  

 The title should be set with initial caps and the entire heading should be in bold. Start 
the text of the section at the left margin.  

 The title level should have a blank line above and six (6)-point spacing beneath 
before the start of the text.  

 The heading should be in Arial 11 point font, the same as the text throughout the 
document. 

 
1.1 Level Two – Title 

The second title heading (example, 1.1) should start at the left margin. 

 The title should begin at 1‖ from the left margin.  

 The title should be set with initial caps. Do not bold this heading. Start the text of the 
section at the left margin.  

 The title level should have a blank line above and six (6)-point spacing beneath 
before the start of the text.  

 The heading should be in Arial 11 point font, the same as the text throughout the 
document. This level should have a minimum of two (example, 1.1 and 1.2). 

 
1.1.1 Level Three – Title 

The third title heading (example, 1.1.1) should start at the left margin.  

 The title should begin at 1‖ from the left margin.  

 The title should be set with initial caps. Do not bold this heading. Start the text of the 
section at the left margin.  

 The title level should have a blank line above and six (6)-point spacing beneath 
before the start of the text.  

 The heading should be in Arial 11 point font, the same as the text throughout the 
document. This level should have a minimum of two (example, 1.1.1 and 1.1.2). 

 
1.1.1.1 Level Four – Title 

The fourth title heading (example, 1.1.1.1) should start at the left margin.  

 The title should begin slightly over 1‖ (the second hash mark after the 1‖) from the 
left margin.  

 The title should be set with initial caps. Do not bold the heading. Start the text of the 
section at the left margin.  

 The title level should have a blank line above and six (6)-point spacing beneath 
before the start of the text.  

 The heading should be in Arial 11 point font, the same as the text throughout the 
document. This level should have a minimum of two (example, 1.1.1.1 and 1.1.1.2). 
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3.8.1 How to Mark Headings in a Document to Generate a Table of Contents 

Each heading level of a document needs to be marked in order to be generated in the Table of 
Contents. To do this, a style must be selected for the document headers. This is located on the 
Home tab by selecting Styles.   
 

 
 

Word has many preset styles to choose from. However, you can create your 
own style as has been done for the Home Energy Plus Style Guide. By 
selecting New Style at the bottom of the Change Style menu, you will be able 
to create your own style. 
 
 
 
 

 

 

 

 

 

3.9 Tables and Figure 

Whenever possible, insert a table or a figure at the top or bottom of a page in a document. It is 
important to position the table or figure as soon as possible after it is mentioned in the text. 
Sometimes, depending on spacing issues, it is necessary to have the table or figure on the next 
page. 
 
The titles of the tables and figures should be centered with the table/figure number on its own 
line. The title of the table/figure should be on its own line beneath the table/figure number. There 
should be three (3)-point spacing beneath the table/figure number and also after the table/figure 
title. No blank line should appear between the table/figure title and the table/figure. 
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Table 1 

Insert Title of Table Here 

Title Title Title Title 

1 2 3 4 

A B C D 

 
Figure 1 

Insert Title of Figure Here 

 
 
 
 

 
 
 

 

 

 

 

 
 
4.0 PowerPoint Presentations 

PowerPoint presentations should use the format outlined in the example below. The Home 
Energy Plus logo should appear in the footer on every slide in the presentation. 
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5.0  Adding Print Screens or Graphics to Documents 

5.1 Inserting a Print Screen and/or Graphic into a Document 

On the Insert tab of the tool bar, locate the Text group. Here the option to insert a type of object 
from a file or other format is available.   
 

 
 
5.2 Cropping and Enlarging Graphics 

The following screen shows where to locate the Crop feature. Cropping print screens and other 
objects inserted into a document gives the opportunity to clean up the picture. 
 

 
 
The following screen is an example of a cropped version of the previous screen. By selecting 
the object, under the Format tab, select the Size option. Select the Crop feature. Clicking on the 
cropping feature and dragging can eliminate unwanted background from the picture. 
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6.0 Portable Document Format (pdf) 

6.1  When to Use a pdf 

When sending a document for review, save it as a pdf. This secures the document as it is 
presented and will avoid formatting issues that might occur if reviewers make changes. It is best 
to have reviewers comment on the document with hand-written notes. When large documents 
are reviewed, provide a word document along with the pdf version so the reviewer can use track 
changes or comment boxes, if they prefer.  
 
6.2 How to Save a pdf 

Sometimes it is necessary to save a document 
as a pdf. Select File then print. Select the 
WECC pdf writer as the printer.   
 
The screen to the left will appear to direct you 
as to how and where to save the pdf document. 
 
 

 

 

7.0 How to Insert a Hyperlink in a Document 

Place the cursor in the document where a hyperlink should be inserted. Right click on the 
mouse. The screen shown on the left (below) will appear. Select Hyperlink. This function will 
take you to the folders on your desktop where other files are saved. If a hyperlink from a Web 
site is needed, copy the URL into the document and press ―enter‖ to attach it to the document. 
Pressing return activates the URL and makes it an active link. 
 
Links within text are bolded, underlined, and colored. The following is an example of a link 
application www.homenergyplus.gov. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

http://www.homenergyplus.gov/
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8.0 Grammar, Word Usage, and Style Standards  

Appropriate grammar, word use, and styles are detailed in the following section.   
 
a.m. and p.m.  

Lowercase, with periods between letters. See time of day. 
 
abbreviations  

As a rule, limit the use of abbreviations. Spell out abbreviations whenever possible, especially 
the first reference, to minimize confusion. See acronyms. 
 
accept and except 

accept – to receive 
except – to include 
 

Examples: Everyone has been notified except Jean. Jean will accept the award for Bob. 
  
acronyms  

Spell out on first reference, even if the acronym is widely known. Follow with the 
acronym in parentheses, and use the acronym consistently in subsequent references. 
Do not capitalize the first letter of the spelled-out words unless they are proper nouns. 
 

Examples: Avoid exposure to volatile organic compounds (VOCs). The U.S. Environmental 
Protection Agency (EPA) issued a ruling.  
 

If an acronym appears in a title or headline, spell out the phrase for which it stands early in the 
text (first sentence or paragraph). Do not use obscure acronyms without explanation. 
 
See the detailed section on acronyms and program names found on page 29 of this document. 
 
active vs. passive voice  

Write in the active voice to make your message more persuasive. Passive voice has its place, 
for marketing communications, it is vague, wordy, and places the customer at arm’s length.  
 

Active: A consultant will perform the assessment. 
 
Passive: An assessment will be performed by a consultant. 

 

afterward 

Not afterwards. 
 
ampersands (&)  

Avoid using the symbol unless it appears as part of a trademark, logo, or official program name. 
 
apostrophes  

In print materials, use the typographer’s apostrophe (’) rather than a prime mark ('). Use prime 
marks only when indicating a measure such as inches or feet. 
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assure, ensure, and insure 

assure – to give someone confidence 
ensure – to make certain 
insure – to protect against loss 
 

Examples:  I want to ensure (make certain) that nothing can go wrong tomorrow. 
I want to insure this necklace (protect it against loss) for $500. 
I want to assure you (give you confidence) that nothing will go wrong. 

 
balloon framed  

Hyphenate when ―balloon‖ and ―frame‖ join together to form a two-word descriptor, also known 
as a compound adjective: balloon-framed structure. 
 
bullet points  

In general, capitalize the first word of each item following a bullet point. Add a period or other 
punctuation after each line if the bullets are full sentences. No punctuation is necessary at the 
end of a list, short phrase, or sentence fragment. If at least one bullet is a sentence fragment 
immediately followed by a complete sentence, use normal end punctuation: a period, question 
mark, or exclamation point for all the bullets. 
 
canceled  

When spelling canceled, use one ―l‖. 
 
capitalization  

Only capitalize proper nouns, proper names, regions, trade names, languages, and words 
derived from proper nouns. Consult Webster’s Dictionary if you are not sure. Avoid initial caps 
on every word for easier reading, especially in headlines, subheads, and the body of forms and 
applications.  
 

Example: Tips for saving energy this summer.  
 
Not: Tips for Saving Energy this Summer. 
 

city  

Do not capitalize city unless part of a proper name or referring to the full name as  
a legal or political entity:  
 

Examples:  Kansas City, Jefferson City. The City of Madison issued an RFP for solar 
electric systems at its firehouses.  
 
Lowercase elsewhere: The city of Madison is located in south-central Wisconsin. A Texas 
city, a city government, the city Board of Education. 

 
colons  

Use only one space after a colon. Capitalize the first word following a colon if it introduces a 
complete sentence. If it introduces a phrase, use lowercase unless it is a proper noun. When a 
colon introduces a bulleted list, use a period after each entry if the bullets are complete 
sentences or phrases that complete the sentence. 
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Example: The results can be summarized as follows: Greenhouse gases contribute to 
global climate change.  
 
Example: The results explain a major cause of global climate change: greenhouse gases.  

 
commas  

Use a serial comma between the last two items in a list, before the coordinating conjunction 
(―and‖ or ―or‖).  
 

Example: The programs help people save energy, money, and the environment.  
 

Leave out the serial comma if there are only two items in a list. A serial comma only belongs in 
a list of three or more items. 
 
If a compound list element contains a comma, consider using semi-colons to separate the main 
list items. 
 

Example: The company offers consumer workshops; contractor training, support, and 
certification; in-field technical assistance; energy-analysis software training and support; and 
more. 

 
Numbers with four or more digits receive commas.  
 

Examples: 1,000, 10,000, and 99,999. 
 
dashes  

Dashes come in three types; be sure to use the right one for each situation. Do not put spaces 
before or after any hyphen or dash in print materials. 
 

hyphen (-) Use between words to form a compound adjective (long-term benefits), with 
some prefix and suffix combinations (co-worker, warm-up), to form adjectival number 
compounds (10-hour day), and to link syllables of a word when it is separated between two 
consecutive lines of type. See hyphenation and hyphenation and modifiers.  
 

Examples: Oct. 12-13, 2008-09, 7-10 feet, 25-30 kilowatts, 40-50%, and pages 1-99. 
 

en or N-dash (–) N-dash gets its name from the fact that it is about the length of a capital 
letter ―N‖ in that particular font and size (from the Insert tab select Symbol and chose the en-
dash from the Symbol tab under Combining Diacritical Marks). It is used between words and 
numbers indicating a range or duration, such as hourly time or months or years. Use it 
where you might also use the word ―to.‖ It is clearer to read a time range when there is 
space around the en-dash between the times. The en-dash is also used as a minus sign to 
indicate a negative number, as with a temperature.  
 

Examples: 7:30 – 9:45 a.m. and –10° F.  
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em or M-dash (—) M-dash is approximately the length of a capital letter ―M‖ and twice as 
long as the en-dash (from the Insert tab select Symbol and chose the em-dash from the 
Symbol tab under Combining Diacritical Marks). The em-dash is often used to set off text 
with increased emphasis. It indicates an abrupt change of thought or clarifies the previous 
statement.  
 

Example: Many residents and businesses are taking advantage of renewable energy 
resources—sun, wind, and biomass. It can also act as a colon in lists, separating a word 
or phrase from its explanation. 

 
When writing for the Web, use hyphens as you would in print materials. However, because 
many browsers have trouble displaying en-dashes and em-dashes, it is acceptable to use 
hyphens in place of these symbols.  
 

Examples: Oct. 12-13, 2008-09, 7:30-9:45 a.m., 7-10 feet, 25-30 kilowatts, pages 1-99. 
Express an em-dash by using a space/hyphen/space combination.  
 
Example: Research proves—saving energy helps businesses reduce operating costs. 

 
database  

One word. 
 

dates  

Always use Arabic numbers, not ordinal. In other words, do not attach -st, -nd, -rd, or -th to the 
ends of dates. 
 

Examples: The applications are due March 5.  
 
Not: The applications are due March 5th. 

 
When a month is used with a specific date, abbreviate only Jan., Feb., Aug., Sept., Oct., Nov., 
and Dec.; always spell out March, April, May, June, and July. Spell out all months when using 
alone or with a year alone. When a phrase lists only a month and a year, do not separate the 
month and year with commas. When a phrase refers to a month, day, and year, set off the year 
with commas. 
 

Example: Dec. 14, 1967.  
 
But: December 1967. 

 
When expressing a range of years, separate the numbers using a hyphen.  
 

Example: 2005-2006 or 1988-89.  
 
Not: ’88–’89. 

 
Use an ―s‖ without an apostrophe to indicate a span of a decade or century: the 1890s, the 
1900s. Years are the lone exception to the general rule that figures cannot be used to start a 
sentence: 1970 was a very good year. 
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decimals  

If no whole number, add a 0 before the decimal point for clarity and ease of reading.  
 

Example: 0.25. 
 
directions and regions  

In general, lowercase north, south, east, west, northeast, and southwest, etc., when they 
indicate a compass direction:  
 

Examples:  She drove west. The storm is moving east.  
 
Examples:  Capitalize these words when they designate regions: The storms originated in 
the Midwest. The North was victorious. He has a Southern accent. 

 
Lowercase compass points when they describe sections of states or cities: western  
Texas, southern Atlanta. Capitalize compass points when they are part of proper names (South 
Dakota, West Virginia) and when they are used to denote widely known regions (Southern 
California, the South Side of Chicago). Follow the same convention for related forms: a person 
from the Southern United States is a Southerner. 
 
e.g. vs. i.e.  
In general, use e.g., in place of ―for example‖ and i.e., in place of ―that is.‖ Always follow these 
initials with a comma. 
 

 Example: Backup is a noun or adjective (e.g., a backup disk).  
 
Example: Your proposal covers all but one point—i.e., how much will the system cost? 
  

except and accept 

except – not to include or, not including 
accept – to receive 
 

Examples: Everyone has been notified except Jean. Jean will accept the award for Bob. 
 
etc.  

et cetera (and so forth) 
 

ext.  

When stating a phone number, use ext. instead of ―x‖ as the abbreviation for extension in all 
customer communications. Use a comma to separate the main number from the extension.  
 

Examples:  1-866-432-8947, ext. 232.  
 
Not: 1-866-432-8947 x 232. 

 
e-mail 

Lower case with a hyphen. 
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ensure, insure, and assure 

ensure – to make certain 
insure – to protect against loss 
assure – to give someone confidence 

 
 

Examples:  I want to ensure (make certain) that nothing can go wrong tomorrow. 
I want to insure this necklace (protect it against loss) for $500. 
I want to assure you (give you confidence) that nothing will go wrong. 

 
Fax 

Fax is short for facsimile. The word ―fax‖ is an acceptable business term.  
 
federal, state  

Capitalize federal or state only when used as part of an official agency name. 
 

Examples: federal government, federal tax credits, state legislation.  
 
But: Federal Bureau of Investigation, State Board of Examiners. 

 

foot marks  

Use the single prime mark (') when indicating a measure of feet.  
 

fractions  

Spell out amounts less than one, using hyphens between words: one-third,  
four-fifths, and seven-sixteenths. Use figures for precise amounts larger than one, converting to 
decimals whenever practical: 1.5, 4.1, and 6.3. 
 
hyphenation  

Hyphenate all compound adjectives (except when the adjective ends in -ly). See hyphenation 
and modifiers. Do not hyphenate adverbs that modify adjectives.  
 

Examples: highly efficient, widely used, nationally known, and publicly funded.  
 
hyphenation and modifiers  

A compound adjective is formed when two adjectives work together to modify the same noun. If 
a compound adjective precedes the noun it modifies, hyphenate it to reduce ambiguity.  
 

Examples:  A ―hot-water system‖ is a system that supplies hot water. A ―hot water system‖ 
is a water system that is currently hot.  

 
Examples: Energy-efficient appliances save money. Brad lives in a high-performance 
home. The program helps limited-income homeowners. Kelly requested a one-page 
overview.  
 
Examples: The appliances are energy efficient. Brad’s home is high performance. 
Homeowners of limited income. The overview is one page. 
 
However; when a compound adjective follows the noun it modifies, do not hyphenate it. 
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Initials  

No space. 
 

Examples: J.R. Ewing 
 

More examples of compound adjectives: energy-saving measure, cost-effective solution, 
heat-recovery system, air-leakage reduction, ground-source heat pump, water-heating 
equipment, variable-speed drive, combustion-zone depressurization, case-by-case basis, 
non-guideline sealing, out-of-office message, and non-energy-related benefits. 

 
Hyphenate compounds in which one component is a number and the other is a noun or 
adjective.  
 

Examples: 30-mile run, 2-part foam, 2,000-square-foot building. 
 
Drop the hyphens and use plural nouns in other uses: The room measured 5 by 8 feet, but a 5-
by-8-foot room. The container held 12 gallons, but a 12-gallon container. Her shift lasted nine 
hours, but a nine-hour shift. He was on vacation for two weeks, but a two-week vacation. 
 
A suspended hyphen (also referred to as a ―hanging hyphen‖ or ―dangling hyphen‖) may be 
used when a single base word is used with separate, consecutive, and hyphenated words which 
are connected by ―and,‖ ―or,‖ or ―to.‖  
 

Examples: Customer education helps residents implement energy- and cost-saving 
strategies. They recommended a 15- to 20-minute break. 

 
i.e. vs. e.g.  

In general, use i.e., in the place of ―that is‖ and e.g., in place of ―for example‖. Always follow 
these initials with a comma.  
 

Example: Your proposal covers all but one point—i.e., how much will the system cost?  
 
Example: Backup is a noun or adjective (e.g., a backup disk).  

 
inch marks  

Use the double prime mark (") when indicating a measure of inches.  
 
insure, ensure, and assure 

insure – to protect against loss 
ensure – to make certain 
assure – to give someone confidence 
 

Examples:  I want to ensure (make certain) that nothing can go wrong tomorrow. 
I want to insure this necklace (protect it against loss) for $500. 
I want to assure you (give you confidence) that nothing will go wrong. 
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job titles  

Capitalize job titles directly preceding a name but not after.  
 

Examples: Executive Director Jane Doe or Mayor John Doe.  
 
But: Jane Doe, executive director; or John Doe, mayor of the City of Madison.  

 
When using a person’s name and title along with a quote, either of the following is acceptable. 

 
Example:  ―The sun will come out tomorrow,‖ said Jane Doe, executive director. 
 
Example:  ―The sun will come out tomorrow,‖ said Executive Director Jane Doe. 
 

lay vs. lie  

A transitive verb is one that takes a direct object. In other words, there is something the action 
of the verb is being done to:  
 
 Example: Please lay the book on the table.  
 
The verb lie is an intransitive verb, so it cannot take a direct object--you cannot ―lie‖ something 
or ―lie‖ something down. 
 
less than and more than  
Use when you mean fewer or more. Under and over generally refer to a spatial relationship. 
 
low-flow  

In materials intended for consumers, use water-saving instead of ―low-flow‖ to accentuate the 
benefit and avoid the negative connotation of ―low-flow.‖ 
 
low income  

Hyphenate when used as a compound adjective EXCEPT when part of a program name.  
 

Example: He works for the Low Income Energy Assistance Program.  
 
Example: The program serves low-income customers.  
 
But: We serve customers of low income. 

 
-ly  

Do not hyphenate adverbs ending in ―-ly‖ and the adjectives they modify. 
 

Examples: widely used, nationally known, and publicly funded. See hyphenation and 
modifiers. 

 
measurements  
Always use figures. Spell out and use the abbreviation in parentheses on first reference in body 
copy, then abbreviate afterward.  
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Examples: A 1-kilowatt (kW) stationary system generates 1,200 kilowatt-hours (kWh) per 
year; a manually adjustable system, 1,260 kWh. The company has four 1.25 kW, non-
tracking solar flags on its grounds. Always spell out when not referring to a specific 
measure.  
 
Example: Electricity is measured in kilowatts.  
 
Not: Electricity is measured in kW. 

 
In general, U.S. measurements take punctuation (in., ft., and sq. ft.); metric measurements do 
not (km, kW, mL, L). U.S. units with ―per,‖ such as ―miles per hour‖ and horsepower (―foot 
pounds per minute‖) usually do not take periods, either (mph, hp). In charts, tables, graphs, and 
lists, express metric measurements using a space between the numeral and symbol in all 
cases, both when they stand alone (20 kW) and as a one-thought modifier before a noun (20 
kW panel). 
 
For clarity, temperatures repeat the degree sign for both the low and high numbers in a range, 
but give the F or C only once—after the last number.  
 

Example: 80°–100° F. See temperature. 
 
For other measurement ranges, do not repeat the measurement description. When stating a 
range in body copy (25 to 30 kWh, 50 to 70 percent, and 80° to 100° F), use the words to or 
through. Use an en-dash in charts, tables, graphs, and lists (25-30 kWh, 50-75%, 80°-100° F). 
 
monetary units  

Use figures and the ―$‖ symbol in all cases except casual references and amounts without 
figures: The lamp cost $4. The registration fee is $75. The new system cost $3,478. She loaned 
me a dollar. Spell out the word cents in lowercase. Use numerals for amounts less than a dollar: 
5 cents, 26 cents, and 78 cents. Use the ―$‖ symbol and decimal system for larger amounts: 
$1.02, $2.75, and $98.33. Do not include .00 when there are no cents in the amount. When 
stating a range, use ―to‖ in the body copy ($20 to $30) but use an en-dash in charts, tables, and 
graphs ($20-$30). Also see numbers.                                                                                                       
months  

Only abbreviate Jan., Feb., Aug., Sept., Oct., Nov., and Dec.; always spell out March, April, 
May, June, and July. Spell out all months when using alone or with a year alone. When a 
phrase refers to a month, day, and year, set off the year with commas. Omit the comma when a 
phrase lists only a month and a year.  
 

Example: Dec. 14, 1967.  
 
But: December 1967. 

 
more than vs. over  

―More than‖ is used with figures. ―Over‖ refers to location.  
 

Examples: She read more than 20 books. He peered over the edge. 
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nonprofit (noun, adj.)  

"In general, do not use a hyphen to set off a prefix at the beginning of a word." − Gregg 
Reference Manual, Third edition. 
 
numbers  

In general, use figures for: 

 Numbers 10 and above. 

 Round or rounded numbers of 1 million or more.  

Examples: 2.75 million, 50 billion. 

 Time designations used with a.m., p.m., B.C., and A.D. If ―o’clock‖ is implied, always 
write out the number: 

Example:  She left at five. 

 Decimals, degrees, percentages, and money: 0.09, 350 °F (spell out degrees and 
Fahrenheit in fact sheet body text), 33 percent, and $67.90. 

 Units of measurement and weight.  

Examples: 20 kilowatts, 12" H x 2" W, 110 lbs. 

 If an abbreviation or symbol is used for the unit of measure, the quantity is always 
expressed as a numeral.  

Example:  8 kW.  

Not: eight kW. 

 Numbers that follow nouns: page 6 in the manual, Chapter 6, Room 103. 
 

Use words for: 

 Common fractions and common expressions: one-half, third party, and the Fourth of 
July. 

 Use numbers for zero through nine when referring to quantity: two, seven, and eight. 

 Numbers that begin sentences: Forty new homes have been certified. 

 Approximate numbers: Approximately twenty new sites will begin projects. 
 

Other tips: 

 Use commas in numbers with four or more digits, except in page numbers, addresses, 
decimals, 1,000, 25,000, and 725,500. 

 Treat ordinal numbers like cardinal numbers (spelling out numbers less than 10): first 
and fifth (spell out number as it is under 10), 15th (use the digit as it is over 10 and when 
used in text). 

 Hyphenate compound numbers between 21 and 99 if spelled out: twenty-five, fifty-nine, 
and eighty-four, especially at the beginning of a sentence. 

 Use to and through for ranges of numbers in body text.  

 When a sentence contains one or more numbers (10 or above) related to a smaller 
number in the same sentence, use numerals for all.  

Example:  The contractor tested 8 devices in May, 12 in June, and 9 in July. 

 To make plurals out of numbers, add s only, with no apostrophe: The 1950s. 

 Use combinations of written and Arabic numerals for back-to-back modifiers:  
Five 4-module panels. 
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 Spell out the word percent in press materials, fact sheet body text, and other 
report/manual-type documents. Use the percent symbol (%) in charts, tables, graphs, 
and lists. See percent. 

 The number of decimal places should be consistent within a list or context: The 
response rates were 42.0 and 48.7 percent, respectively. 

 
on-site  

Hyphenate when used as a compound adjective.  
 

Example: He scheduled an on-site energy evaluation.  
 
But: The evaluation was conducted on site. 

 
online (noun, adj.) 

Do not hyphenate. 
 
ordinal numbers  

Superscript numbers that end in -st, -nd, -rd, and –th. 
 

Example: The 10th District.  
 
Not: The 10th District. Avoid ordinal numbers in dates.  
 
Example: The offer ends September 30, 2009.  
Not: The offer ends September 30th, 2009. 

 
over vs. more than  

Over refers to location. More than is used with figures.  
 

Examples: He peered over the edge. She read more than 20 books. 
 

pdf 

―pdf” stands for Portable Document Format The acronym ―pdf‖ is an acceptable business term. 

 

p.m. and a.m.  

Lowercase, with periods between letters. See time of day. 
 
percent  

Use figures for all percentages, including numbers less than 10. Spell out the word percent in 
press materials and fact sheet body text, but use the symbol (%) in, charts, tables, graphs, and 
lists. Do not repeat the symbol or word when citing a range.  
 

Example (fact sheet): Phantom power accounts for 4 to 7 percent of total energy use in the 
average home. Use decimal points, not fractions, when appropriate: 64.5 percent. For 
amounts less than 1 percent, precede the decimal point with a zero: 0.7 percent.  
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periods  

Use only one space after a period. Use one period at the end of a declarative sentence, even if 
it ends with an abbreviation or a Web address.  

 
Example: Efficiency tips are available at energystar.gov.  
 

When a colon introduces a bulleted list, use a period after each entry if they are complete 
sentences or phrases that complete the sentence. 
 
plural acronyms  

When the acronym does not use periods, add an ―s‖ to form the plural.  
 

Examples: CFLs, CPUs, and LANs.  
 
Exception: Btu is the same singular as plural. When the acronym uses periods, add an 
apostrophe and ―s‖ (’s) to form the plural.  
 
Example: Ph.D.’s. 

 
quotation marks  

Use straight quotes (′ and/or " ) when indicating a measure such as inches or feet.  
 
real time vs. real-time  
Two words when used as a noun; hyphenated when used as an adjective.  
 

Example: GreenTouchscreen® shows the building’s energy production in real time.  
 
But: real-time information. 

 
seasons  

Lowercase the names of seasons (winter, spring, summer, or fall) unless part of a formal title: 
Summer Olympics, Madison's Winter Party. 
 
showerhead  

One word. In materials intended for consumers, use water-saving showerhead instead of low-
flow showerhead to accentuate the benefit and avoid the negative connotation of ―low-flow.‖ 
 
site-specific 

Two words with a hyphen. 
 
slashes (/)  

No space before or after a slash. 
 

 Examples: and/or, if/when, and city/state/ZIP. 
 
spacing between sentences  

Use only one space between sentences and after colons.  
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state and federal  
Capitalize state or federal only when used as part of an official agency name.  
 

Examples: state legislation, state funds, the state of Wisconsin, federal government, and 
federal tax credits.  
 
But: State Board of Examiners, Federal Bureau of Investigation. 

 
state names  

Always spell out state names when they stand alone (without a city name) in text. Abbreviate 
when using with a city or county name—using the following abbreviations: Ala., Ariz., Ark., 
Calif., Colo., Conn., Del., D.C., Fla., Ga., Ill., Ind., Kan., Ky., La., Md., Mass., Mich., Minn., 
Miss., Mo., Mont., Neb., Nev., N.H., N.J., N.M., N.Y., N.C., N.D., Okla., Ore., Pa., R.I., S.C., 
S.D., Tenn., Vt., Wash., W.Va., Wis., Wyo. Spell out all other states.  
 
Note: treat ―D.C.‖ as a state when used to refer to the nation’s capital, and is set off with 
commas: We accepted the award in Washington, D.C. 
 
The two-letter postal abbreviations (WI, IL, MN, and KY, etc.) need only be used on mailing 
envelopes where they can be electronically scanned at the post office, thereby expediting 
sorting and delivery. Thus, NY on the envelope and N.Y. or New York on the materials inside. 
 
statewide  

One word. See wide-, -wide.  
 
telephone numbers  

State phone numbers in the following format: 1-866-432-8947. If extension numbers are given: 
ext. 2, ext. 364, and  ext. 4071, use a comma to separate the main number from the extension: 
1-866-432-8947, ext. 232. 
 
time of day  

Use figures for all times except noon and midnight. Use zeros when there is no distinction for 
minutes and include a.m. and p.m., lowercase with periods: The conference starts at 8:00 a.m. 
Use one space between the time and p.m. or a.m. Use CT instead of CST (Central Standard 
Time) or CDT (Central Daylight Time) when stating hours of service. 
 
Express start and end times as follows:  

8:00 − 9:00 a.m. 
11:00 a.m . − 1:00 p.m. 
6:30 − 8:30 p.m. 
 

It is clearer to read a time range when there is space around the en-dash between the times. 
 
titles of works  

Italicize titles of books, magazines, newspapers, newsletters, pamphlets, and reports.  
 
 Example: Weatherization Technical Shorts Newsletter 
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Titles of articles and features in magazines and newspapers, chapter titles and part titles, titles 
of short stories, and essays are enclosed in quotation marks.  
 
 Example: ―Madison a winner in national water conservation challenge.‖ 

 
Titles of book series and editions are capitalized without quotation marks. 
 

Example: Moby Dick 
 
titles of works  

Italicize titles of books, magazines, newspapers, newsletters, pamphlets, and reports.  
 
Titles of articles and features in magazines and newspapers, chapter titles and part titles, and 
titles of short stories and essays are enclosed in quotation marks. Titles of book series and 
editions are capitalized without quotation marks. 
 
toward  

Not towards. 
 
U.S. vs. United States  

Use U.S. only as an adjective; use United States as a noun: U.S. Supreme Court. She lives in 
the United States. 
 

USA  

United States of America. No punctuation, no spaces. 
 
under  

Beneath in a spatial relationship. Less than is preferred in a count of individual items. 
 

Example: Less than $50. 
 
Web addresses  

Always precede URLs with www. 
 

Example: www.homeenergyplus.wi.gov.  
 

Use one period at the end of a declarative sentence even if it ends with a Web address. 
 
Example: He downloaded the fact sheet from www.homeenergyplus.wi.gov. 

 
Web, Web site, Web page 

Whenever ―Web‖ is used, it should be capitalized. 
 
who vs. that 

Use who, not that, to refer to people. That is for groups and things.  
 

Examples:  the girl who played; the team that won. 
 

http://www./
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who vs. whom  

Would the answer to the question be he or him? 
 

Example: If you can answer the question with him, then use whom, they both end with ―m‖. 
If you can answer the question with he, then use who. 
 
Use whom when referring to the object of a verb. 

 To whom it may concern:  

 To whom did you talk today?  

 
Use who when referring to the subject of a sentence or phrase. 

 Who brought the paper inside?  

 Who talked to you today?  

 
wide-, -wide  

Follow Webster’s Dictionary. Prefix is usually hyphenated. Suffix generally is not hyphenated.  
 

Examples: wide-angle, statewide. 
 

Wisconsin statutes  

Lowercase and spell out statute unless referring to a specific statute. Abbreviate as Wis. Stat.  
 

Example: Wis. Stat. §§ 19.81 through 19.98.  
 

years  

When expressing a range of years, separate the numbers using a hyphen.  
 

Example: 2005-2006 or 1988-89.  
 
Not: ’88-’89. 

 
ZIP code  

Capitalize the acronym ZIP: Zone Improvement Program. Lowercase the word code. 
 
  

http://www.wikihow.com/Ask-a-Question-Intelligently


 

Home Energy Plus   Style Guide  27 

May 2012 

9.0 Program Names, Acronyms, and Definitions  

All company, department or division names, or other acronyms should be spelled out on first 
reference, even if the acronym is widely known. Follow with the acronym in parentheses, and 
use the acronym consistently in subsequent references. Do not capitalize the first letter of the 
spelled-out words unless they are proper nouns. 

Examples: Avoid exposure to volatile organic compounds (VOCs). The U.S. Environmental 
Protection Agency (EPA) issued a ruling. If an acronym appears in a title or headline, spell 
out the phrase for which it stands early in the text (first sentence or paragraph). Do not use 
obscure acronyms without explanation. Below is a list of common acronyms related to 
energy efficiency and programs.   

ACH Air changes per hour 

AFUE  Annual Fuel Utilization Efficiency 

ARRA  American Recovery and Reinvestment Act  

ASHRAE  American Society of Heating, Refrigeration, and Air Conditioning Engineers 

Btu  British thermal unit 

CFL  Compact Fluorescent Lighting  

CFM  Cubic Feet per Minute 

CFM50 Cubic Feet per Minute at 50 pascals of pressure 

CAZ  Combustion Appliance Zone 

DES Division of Energy Services 

DOA Department of Administration  

DOE  The United States Department of Energy  

DTL Depressurization Tightness Limit 

ECM  Energy Conservation Measure − Add an s to form the plural: ECMs, not ECM’s 

EPA  Environmental Protection Agency 

GFCI  Ground fault circuit interrupter 

HRV Heat Recovery Ventilator    

HVAC Heating, Ventilation, and Air Conditioning   

kW  Kilowatt − Spell out when not referring to a specific measure. Examples: The new 
fan saves 4 kilowatts. Electricity is measured in kilowatts. Not: Electricity is 
measured in kW. 

kWh  Kilowatt-hour − Spell out when not referring to a specific measure. Examples: 
One kilowatt-hour (kWh) will light a 100-watt bulb for 10 hours. The measure 
saves 70 kilowatt-hours (kWh) per month. 

Not: One kWh will light a 100-watt bulb for 10 hours. 

LHR  Lead Hazard Reduction  

LIHEAP  Low Income Home Energy Assistance Program − Federal Energy Assistance  

MHEA  Mobile Home Energy Audit 

MSDS  Material Safety Data Sheet 

NEAT  National Energy Audit Tool 

PB  Public Benefits 

PSC  Public Service Commission  
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psi Pounds per square inch 

R-value Resistance value 

SIR  Savings-to-investment ratio  

SSE  Steady State Efficiency 

U-factor Energy Factor of a Window (inverse of the R-value) 

WAP  Weatherization Assistance Program  

WCEG  Weatherization cost-effective guidelines 

WisWAP  Wisconsin Weatherization Assistance Program (generally used to refer to 
Wisconsin's production reporting data base) 

WECC  Wisconsin Energy Conservation Corporation  

WHEAP  Wisconsin Home Energy Assistance Program or EA (Energy Assistance) 
 
Note ENERGY STAR® does not have an acronym. When using ―ENERGY STAR®,‖ capitalize 
both words in all instances. A registered trademark symbol (®) in superscript is to be used with 
the first reference of ENERGY STAR in a document. 
 
9.1 Wisconsin Weatherization Agencies 

ADVOCAP, Inc. 
Ashland CHA  
Rock/Walworth 
CAP Services, Inc. 
Central WI CAC 
Partners for Community Development 
Hartford CDA 
Indianhead Community Action Agency 
La Casa de Esperanza (Milw) 
La Casa de Esperanza (Cty) 
NEWCAP, Inc. 
North Central CAP 
Weatherization Services OCHA  
Project Home 
Racine/Kenosha CAA 
Southwest CAP 
West CAP 
Western Dairyland E.O.C. 
Couleecap, Inc. 
Women’s Employment Services 
Social Development Commission 
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9.2 Wisconsin WHEAP Agencies 

Region A 
Ashland County Health and Human Services Department 
Bad River Tribe 
Bayfield County 
Burnett County Department of Health and Human Services 
Clark County Department of Social Services 
Douglas County Department of Health and Human Services 
Iron County Human Services 
Lac Courte Oreilles Band 
Lac Du Flambeau Tribe 
Oneida County Department of Social Services 
Price County Department of Health and Human Services 
Red Cliff Tribe 
Rusk County Department of Health and Human Services 
Sawyer County Health and Human Services 
Taylor County Human Services Department 
Vilas County Department of Social Services 
Washburn County Health and Human Services Department 
 
Region B 
Barron County Department of Health and Human Services 
Buffalo County Department of Health and Human Services 
Chippewa County Department of Human Services 
Couleecap Inc.  
Crawford County Human Services Department 
Dunn County Department of Human Services 
Eau Claire County Department of Human Services 
Jackson County Department of Health and Human Services 
La Crosse County Human Services 
Monroe County Department of Human Services 
Pepin County Department of Human Services 
Pierce County Department of Human Services 
Polk County Department of Human Services 
St. Croix County Health and Human Services 
Trempealeau County Department of Human Services 
Vernon County Department of Human Services 
Western Dairyland Economic Opportunity Council, Inc. 
 
Region C 
Brown County Human Services 
Door County Department of Social Services 
Energy Services Inc. 
Florence County Human Services 
Forest County Department of Social Services 
Integrated Community Solutions 
Kewaunee County Department of Human Services 
Langlade County Department of Social Services 
Lincoln County Department of Social Services 
Marathon County Department of Social Services 
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Marinette County Health and Human Services 
Menominee County Health and Human Services Department 
Newcap, Inc. 
Oconto County Department of Health and Human Services 
Oneida Nation 
Shawano County Department of Social Services 
Sokaogon Chippewa/Mole Lake 
Stockbridge Munsee Tribe 
Women’s Employment Project 
Wood County Department of Human Services 
 
Region D 
Adams County Health and Human Services Department 
Calumet County Department of Human Services 
Central Wisconsin Community Action Coalition Inc. 
Columbia County Department of Health and Human Services 
Energy Services Inc. 
Fond du Lac County Department of Social Services 
Green Lake County Department of Health and Human Services 
Juneau County Department of Human Services 
Manitowoc County Human Services Department 
Marquette County Department of Human Services  
Outagamie County Department of Health and Human Services 
Ozaukee County Department of Human Services 
Portage County Health and Human Services Department 
Sauk County Department of Human Services 
Sheboygan County Health and Human Services 
Waupaca County Department of Health and Human Services 
Waushara County Department of Human Services 
Winnebago County Department of Human Services 
  
Region E 
Community Advocates 
Dane County Department of Human Services 
Dodge County Health and Human Services Department 
Energy Services Inc. 
Grant County Department of Social Services 
Green County Human Services 
Iowa County Department of Social Services 
Jefferson County Human Services Department 
Kenosha County 
Lafayette County Human Services 
Milwaukee County Department of Health and Human Services 
Racine County Department of Human Services 
Richland County Health and Human Services 
Rock County Human Services Department, Economic Support Division 
Social Development Commission 
Spanish Center 
Walworth County Department of Health and Human Services 
Washington County Human Services Department 
Waukesha County Department of Health and Human Services 


